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Part 1: Introduction

About this Manual

Intended Use of this Manual

• This man ual de scribes the com mon use pro ce dures of the PlateWriter 2000 Sys tem.
It is in tended for the daily user and should be kept with the equip ment for ref er ence
at all times. 

"
Printer-specific information relating to operation, maintenance and service can 
be found in the manuals supplied on the CD with your printer.

Reservations

• This man ual was writ ten and il lus trated us ing the best pos si ble in for ma tion avail -
able at the time of pub li ca tion.

• Any dif fer ences be tween this man ual and the equip ment re flect im prove ments in tro -
duced af ter the pub li ca tion of the manual.

• Changes, tech ni cal in ac cu ra cies and ty po graph i cal er rors will be cor rected in sub se -
quent edi tions.

• As a part of our pol icy of con tin u ous im prove ment, we re serve the right to al ter de -
sign and spec i fi ca tions with out fur ther notice.

Notes, Cautions, and Warnings

Through out the man ual notes, cau tions, and warn ings are writ ten in bold like the
ex am ple be low:

$
Al ways re place a fuse with one of the same size and rat ing as the old one.

Symbol Meaning Explanation

"
Note

The operator should observe and/or act according to the

information in order to obtain the best possible function of

the equipment.

$
Caution

The operator must observe and/or act according to the

information in order to avoid any mechanical or electrical

damage to the equipment.

#
Warning

The operator must observe and/or act according to the

information in order to avoid any personal injury.
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Important

Safety and Use

• Be fore us ing the equip ment it is as sumed that it has been prop erly in stalled and con -
fig ured as de scribed in the in stal la tion man u als de liv ered with the system.

• The man u fac turer can not be held re spon si ble for any dam age caused by in cor rect
use of this equip ment.
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The PlateWriter 2000 System

The PlateWriter 2000 System is an innovative and patented inkjet Computer-to-Plate
(iCtP) device.

The PlateWriter System consists of:

• PlateWriter En gine (1)
A spe cially mod i fied Epson Sty lus Pro 4880 inkjet printer that uses Glunz & Jensen's
Liq uid Dot fluid to im age the iPlates print ing plates.

• Plate In put Ta ble (2)
A ta ble for align ing plates prior to en ter ing into the PlateWriter 2000 En gine.

• Proofer
An un mod i fied Epson Sty lus Color 4800, 4880 or 7800, 7880 printer used for proof -
ing. Plug-ins to drive these print ers are sup plied with the Har le quin RIP

• Har le quin RIP Plat form
A cus tom ized work sta tion ac ces si ble by both Mac and PC com put ers, loaded with
the lat est ver sion of the Global Graphics Har le quin RIP.
The Har le quin RIP pro vided is cus tom ized by Xitron and it ac cepts Post Script, PDF,
EPS, TIF & JPEG files pro duced by stan dard pre-press ap pli ca tions.
It RIPs the data and sends out put to the PlateWriter Engine or to the Proofer

• PlateWriter Fin ish ing Unit (3)
An in te grated plate fin isher that ex e cutes all of the steps nec es sary to pro duce
press-ready plates, i.e: cur ing, gum ming and dry ing of the plates af ter they are im -
aged in the PlateWriter Engine.
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PlateWriter Overview

1 Front Plate Table: place plates here before printing.
2 Control Panel: from here you control the Imaging Unit (see details on page 1-6).
3 Input table: Ensures that plates are aligned correctly prior to entering the Imaging Unit.
4 Ink Dryer: improves the drying of the Liquid Dot ink on the plate.
5 Rear Plate Table: when a plate has been loaded it will be transported to here before

printing starts.
6 Curing Conveyor: leads the printed plate through the curing sections.
7 Curing Oven: dries the ink on the plate and cross-links it to the aluminum base.
8 Gum/Finishing Bottle: contains the finishing solution applied to the plate in the finishing

section. Solution not accepted by the plate returns into the bottle.
9 Finishing Section: cools the plate and applies a combined gum- and plate enhancer to the

plate to protect it from oxidation and to improve its press characteristics and hydrophilic
properties when on press.

10 Gum Dryer: dries the plate to provide a finished, dry plate.
11 Plate Exit Tray: holds the finished plates.
12 Ink Cartridges: There are two compartments on each side of the printer. Each compartment

can contain up to 4 ink cartridges. 
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13 Status Indicator LED: indicates the current status of the Finishing Unit.
14 Program Selector: for selection of the Curing Oven program.
15 USB-cable: connects the Imaging Unit with the RIP Workstation.
16 Power Cable: supply voltage for the Imaging Unit.
17 Power Switch: press here to switch the Imaging Unit On/Off.
18 Power Switch: press here to switch the Finishing Unit On/Off.
19 Power Cable: supply voltage for the Finishing Unit.
20 Control Cable: connects the Ink Dryer with the Finishing Unit.
21 Power Cable: supply voltage from Finishing Unit to the Ink Dryer.
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Part 2: Daily Use

Overview

The daily use procedures described in this chapter cover the following issues:

• Daily Start-Up pro ce dure

• Load ing of plates into the PlateWriter for print ing

• Print ing of plates

• Fin ish ing

• Daily Shut-Down pro ce dure

Daily Start-Up

• Start the RIP Work sta tion (1). 

• Launch the RIP Ap pli ca tion (2).

• Re place the fin isher so lu tion in the fin -
ish ing bot tle (3) with fresh fin isher so -
lu tion.

"
Half a bot tle is suf fi cient.

Operating Manual - PlateWriter
TM

 2000 0749

Daily Use
2-1

Overview

12

3



• If you see the mes sage MNT TNK
FULL on the LCD dis play, you need
to re place the main te nance tank.
Place the used tank in the plas tic
tank sup plied with the new tank. In -
sert the new tank.

• Switch on the Fin ish ing Unit on the
main switch (5) underneath and
make sure that the in di ca tor (6) lights 
steady green.

• The unit will run gum fluid through
the sys tem for ap prox i mately three
min utes to en sure an even gum ming
of the plates.

"
This will also switch on the Ink
Dryer.

• Switch on the PlateWriter by press -
ing the [POWER] but ton.

• The PlateWriter initializes and when
fin ished, the dis play (8) shows
”READY”.
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Making a Proof

Creating Files for Proofs

• Use your DTP ap pli ca tion to pre pare a com pos ite out put file - please re fer to your
ap pli ca tion man ual for help.
Se lect an out put page size suf fi ciently large to ac com mo date your con tent and any
reg is tra tion marks or colour bars.

• Save the file to a folder, ei ther on the com puter run ning Nav i ga tor RIP or on a
server.

Printing a Proof

• In the Nav i ga tor RIP open the Out put Con trol ler / Mon i tor win dow by ei ther
press ing Ctrl+O or choos ing Out put -> Out put Con trol ler from the RIP menu.

• Be sure that Dis able Out put is checked.

• Se lect File -> Print file from the RIP menu.
Choose an ap pro pri ate Proof ing Page Setup and a file type (.ps, .pdf, .eps, .jpg or .tif) 
from the di a logue.
Nav i gate to the folder con tain ing your com pos ite files, choose one file, and click on
Print.

• The file will be ripped and will ap pear in the Ac tive Queue of the Out put Mon i -
tor/Con trol ler win dow.

• Uncheck Dis able Out put in the Out put Con trol ler/Mon i tor win dow. The proof will 
be printed.
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Making Plates

Creating Files for Plates

• Use your DTP ap pli ca tion to pre pare sep a ra tion out put files - please re fer to your
ap pli ca tion man ual for help. 

• Se lect an out put page size suf fi ciently large to ac com mo date your con tent and any
reg is tra tion marks or col our bars - it should not be the same size as your plate. The
RIP will po si tion a smaller page cor rectly on your plate for you.

• Save the file to a folder, ei ther on the com puter run ning Nav i ga tor RIP or on a
server.

Loading Plates on the PlateWriter

The input table ensures that plates are fed into the printer correctly. The side register
rollers (see below) enable correct and easy alignment prior to entering the printer.

• Place the plate on the in put ta ble against the reg is ter wheels on the left side and slide 
the plate into the printer. 

• If the plate is fed in cor rectly into the printer, the LCD dis play will show the mes sage 
“NOT STRAIGHT - RELOAD”.
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Imaging the Plate 

• In the Nav i ga tor RIP open the Out put Con trol ler / Mon i tor win dow by ei ther
press ing Ctrl+O or choos ing Out put -> Out put Con trol ler from the RIP menu.

• Be sure that Dis able Out put is checked.

• Se lect File -> Print file from the RIP menu.
Choose an ap pro pri ate PlateWriter 2000 Page Setup that matches your print job and
the ori en ta tion of the loaded plate, then choose a file type (.ps, .pdf, .eps, .jpg or .tif).
Nav i gate to the folder con tain ing your sep a ra tion files, choose the files, and click on
Print.

• The files will be ripped and will ap pear in the Ac tive Queue of the Out put Mon i -
tor/Con trol ler win dow.

• The ink (col our) of each sep a ra tion will be dis played in brack ets af ter the job name,
and if there are mul ti ple pages, then each page will be des ig nated with a nu meric
value.

• Se lect your file and click on Info.

• The Through Put Info win dow ap pears.
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• Be sure that Change all pages in job is checked.

• Click on Page lay out... to open the Page Lay out win dow.

• Check that the size of your plate is cor rectly en tered in the Me dia Width [MW] and
Me dia Length [ML] boxes. Most plates will be im aged por trait in the PlateWriter
2000. De pend ing on whether you are load ing the plates in por trait or land scape and
whether you have a por trait or land scape press, dif fer ent se lec tions have to be made. 
If you load the plate in por trait and have a land scape press, be sure to se lect the
Cen ter page on Me dia Length and set the Left Mar gin [LM] to ac com mo date the
nor mal un print able area on your press. (also known as the Grip).

• If you have a por trait press, and have loaded the plate por trait, then make sure to se -
lect the Cen ter page on Me dia Width and set the Top Mar gin [TM] to ac com mo -
date the nor mal un print able area on your press.

• Click OK in the Page Lay out win dow and in the Through Put Info win dow.

• Drag all but the first sep a ra tion of your job to the Held Queue.

• Uncheck Dis able Out put in the Out put Con trol ler/Mon i tor win dow. The first plate
will be printed.

• Re move the plate from the PlateWriter and place it on the front of the Plate Writer
fin ish ing unit, see fin ish ing pro ce dure in the fol low ing sec tion.

• For sub se quent plates, make sure that Dis able Out put is checked, load a plate into
the PlateWriter 2000, drag one sep a ra tion from the Held Queue to the Ac tive
Queue, and then uncheck Dis able Out put.
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Finishing

• Use +/- but tons on the Pro gram Se -
lec tor (1) to se lect pro gram:

1 = 0.15 mm plates
2 = 0.20 mm plates
3 = 0.30 mm plates
4 = Gum ming only/Gum Rinse

"
Pro gram 0 is for tech ni cians
only!

• Make sure that the in di ca tor (2)
lights steady green.

"
For the var i ous in di ca tor sta tus
and er ror codes please see chap -
ter 5 “Troubleshooting”.

• Place the printed plate (3) on the con -
veyor mak ing sure that the front
edge is placed over the plate sen sor
(4).

• If the cur ing oven has al ready
reached the cor rect work ing tem per -
a ture, the con veyor will take the
plate through the oven, oth er wise it
moves the plate slightly for ward and 
then it stops un til the oven is ready.

• The in di ca tor (5) will start to flash in -
di cat ing that the unit is busy. Do not
in sert an other plate while in di ca tor is 
flash ing.

• When fin ished the plate is placed on
the exit tray (6).
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Daily Shut-Down

• Switch the unit into OFF-mode by press ing and hold -
ing the [POWER] key (1) for 2 secs. All lights turn off
and the dis play will go blank.

• When in OFF-mode the unit will still “wake up” at
in ter vals and per form the main te nance cy cle and
then au to mat i cally re turn to OFF-mode.

Important notes about switching the Power On and Off

Never switch off the main power while the sub power is switched on. The printing
heads may be left uncapped (the printing carriage may remain over the Plate
Alignment Mat). If the machine is left unused with the printing heads uncapped for a
prolonged period, the printing heads may become irreversibly clogged.

Before switching off the main power, be sure to hold down the [POWER] key for one
second or longer to switch off the sub power.

If the printing carriage stops while over the platen, press the [POWER] key to reset the
power. The printing carriage moves and the printing heads are capped.
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Part 3: Cleaning & Maintenance

Overview

This section describes the various procedures for care and maintenance such as:

Printer

Please refer to the Printer Guide

Finishing Unit

• Re plac ing the Gum/Fin isher So lu tion (Daily)

• Run ning the Gum Rinse Pro gram (Weekly)

• Clean ing of the Gum/Fin isher Roll ers (Monthly)
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Inks and Fluids

The PlateWriter requires the use of various inks and fluids for processing, cleaning and 
maintenance purposes:

Liquid DotTM (1)

The Liquid Dot
TM

 ink is supplied in special cartridges and used in the imaging channels 
to create a hydrophobic image on the printing plate.

Maintenance Fluid (2)

The Maintenance Fluid is a general purpose fluid supplied in special cartridges, and is
used to keep the unused print heads available for use as backups. It can also be used as 
a light cleaning fluid.
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WARNING!

CONTAINS       1- Methoxy - 2 - Propanol      107 - 98 - 2

                                  

FIRST AID
• If inhaled, r

• FLAMMABLE LIQUID AND VAPOUR.

• HARMFUL IF INHALED.

• MAY BE HARMFUL IF SWALLOWED OR ABSORBED THROUGH SKIN.

• MAY CAUSE IRRITATION TO SKIN, EYES, AND RESPIRATORY TRACT.

Ammonia                                    1336 - 21 - 6

For additional information, please see Material Safety Data Sheet (MSDS).

emove to fresh air. If not breathing, give artificial respiration.

   If breathing is difficult, give oxygen. Get medical attention.

• In case of contact,  immediately flush skin with plenty of water for at least 15

  minutes while removing contaminated clothing and shoes. Wash clothing

  before reuse. Thoroughly clean shoes before reuse. Get medical attention if

  symptoms occur.
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Replacing the Ink Cartridges

If ink runs out, replace the cartridges as described in the following.

$
Never use any ink other than genuine Liquid Dot ink from Glunz & Jensen.
Doing so may result in malfunction or faulty operation.

Care and Handling of Ink Cartridges

Give attention to the following points when handling ink cartridges.

• Never at tempt to in stall any ink other than a Liq uid Dot car tridge.

• Never at tempt to dis as sem ble.

• Never drop or al low to fall. The im pact from a fall may cause dam age, mak ing the
car tridge un us able.

• Store un opened in a well-ven ti lated lo ca tion where the tem per a ture is from -20ºC
(-40ºF) to 40ºC (104ºF).

• Once an ink car tridge has been in stalled, never re move it un til the ink has been used 
up, ex cept when mov ing the ma chine.
Fre quent in ser tion and re moval may cause air to en ter the ink tube, re sult ing in dot
drop-out or other prob lems in print ing quality.

• Al ways be sure to gently shake the ink car tridge be fore you in stall it.

• Re mov ing or in sert ing an ink car tridge while op er a tion is in prog ress may cause air
to get in side the car tridge, re sult ing in poor im age quality.

• Af ter re mov ing an ink car tridge, never al low the ma chine to stand with the ink-car -
tridge port re main ing empty — in stall a new ink car tridge im me di ately. Fail ure to
do so may re sult in clog ging of the heads.
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Other Printer Cleaning Tasks

General

Exposed areas of the machine may become soiled with ink during printing.
The cleaning methods described below let you continue printing without affecting the
printed media or the machine.

"
When carrying out any cleaning other than cleaning using cleaning sticks,
switch off the main power (before turning off the main power, press the
[POWER] key to switch off the sub power.)
Never lubricate the mechanisms.
Never clean with solvents (such as benzine or thinners).
Never touch the printing heads or allow the printing heads to come in contact
with anything except ink.

Cleaning the Printer Body

Use a cloth moistened with water then wrung well, and wipe gently to clean all
surfaces.
Wipe the operation panel and LCD display gently with a clean, soft cloth.

#
Do NOT put wet plates back in the printer. This will cause the image to
transfer to the rollers and on every subsequent plate!
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Finishing Unit

Running the Gum Rinse Program

"
It is recommended to run the Gum Rinse Program at the end of each working
period (preferably once a week).

• Re place the so lu tion in the Gum/Fin isher bot tle with warm wa ter.

• Se lect Pro gram 4 on the Pro gram Se lec tor to start the Gum Rinse Pro gram.

• The unit will run for approximately 10 minutes re cir cu lat ing the wa ter through the
gum ming sys tem and then it switches to stand-by mode.

• Leave the unit with wa ter un til the start of the next work ing pe riod, then re place the
wa ter with fresh Gum/Fin isher So lu tion.

#
Danger of crushed fingers when working inside the Finisher section, proceed
with caution. Always replace the side plate after completing cleaning and
maintenance tasks in the Finisher section.

$
Always replace the side plate after cleaning and maintenance of the Finisher
section. Failure to do this will result in inferior processing quality. 

Procedure for accessing the Gum/Finisher section

See figure opposite

• Turn off the power sup ply to the ma chine.

• Re move the plug from the socket. 

• Lift the side plate by its knob and push it into the re cess where it can be stored while 
work ing in the sec tion. 

You can also remove the covers of the curing oven and gum dryer for easier access.
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Cleaning of Gum/Finisher Rollers

"
It is recommended to perform this cleaning procedure once a month.

(See illustration opposite)

• Switch off and un plug the Fin ishing Unit.

• Re move the Gum Dryer (1).

• Re move the Gum Sec tion Cover (2).

• Take out the roller (3).

• Re lease the roller bear ings (4) and take out the roll ers (5) and (6).
To re lease the roller bear ings, press the lock ing arm as il lus trated, and then pull up -
wards.

• Clean the roll ers and bear ings in hot wa ter us ing a soft brush.

• Re in stall all parts in re verse or der, mak ing sure that the bear ings (4) click prop erly
into place.

Cleaning the Finishing Unit Body

Use a cloth moistened with water then wrung well, and wipe gently to clean all
surfaces and conveyor belts.
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Gum/water Replenishing System

Use

• De pend ing on the size of the plate, the fin ish ing unit sets aside a lit tle wa ter pump
run time (ap prox i mately 1 s for ev ery 60 sec onds that the fin ish ing unit is run ning).
Once the plate has passed through the ma chine, the wa ter pump re plen ishes the re -
served amount of wa ter and dis trib utes it to clean the rollers. 

• If plates are con tin u ously run ning through the fin ish ing unit, it will con tinue re serv -
ing wa ter re plen ish un til it has ac cu mu lated 30 sec onds. The fin ish ing unit lights
green (ready) as soon as wa ter re plen ish is added.

"
Do not turn off the finishing unit before it is ready (green). This ensures that
water replenish is added and will stop the rollers from sticking together the
next day. 

• If the fin ish ing unit is turned off be fore re -
plen ish has been added, any saved re plen -
ish will be de leted. 

• The wa ter tank (1) must be placed be low
the gum bot tle with the cap in the tray dis -
mounted. The wa ter tank func tions as a
drip tray for the gum bot tle.

Cleaning

• The wa ter tank must be emp tied and
cleaned once a week, for in stance when
chang ing gum. 

• Re fill with de min er al ised wa ter only to
avoid con tam i na tion of gum/plates.

• With the gum/wa ter re plen ish sys tem in stalled, gum should only be changed/re -
filled and cleaned once a week.

Gum con sump tion will be ap prox i mately 20 g/m².

Water consumption will be approximately 40 g/m².

"
Depending on the throughput in the finishing unit, you should calculate how
much gum and water to put in the gum bottle and water tank to make the gum
last one week. If there is less than 25% gum remaining in the bottle when
commencing work with the printer in the morning, it is a good idea to top up. 
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Part 4: Using the RIP

Overview of the Navigator RIP

The Navigator RIP is an application that takes a document or job describing images or
pages and produces output from that job on an output device - which in this case is
either the PlateWriter 2000 or a proofing device.

In general, a software application or hardware device that performs this task is known as 
a Raster Image Processor (RIP) or, where the PostScript

®
 language is involved, a

PostScript-language compatible interpreter.

The iCtP RIP workstation is not just a Navigator RIP, it is a RIP management system.
It contains both a RIP and a collection of supporting functions that help the RIP
perform its task effi ciently.

For example, the iCtP Workstation accepts jobs from various platforms such as Mac or
PC, different sources (from disks, CD’s, shared folders on Networks or virtual printers
visible to other users), the iCtP RIP Workstation also handles previewing and output of 
processed pages, and performs the associated file handling.

Input formats

The Navigator RIP accepts jobs from most major graphics applications and supports
the following formats, with the exact options depending on your configuration of the
RIP.

The input formats includes: 

• Post Script-lan guage (PS) files

• En cap su lated Post Script (EPS) files

• Por ta ble Doc u ment For mat (PDF) files

• TIFF/IT-P 1 files

• (16-bit) TIFF 6.0 base line files

• JPEG and JFIF files

The Navigator RIP supports modern versions of these files including PostScript
Language Level 3, PDF version 1.5, and derived standards such as PDF/X.
The RIP also has controls for special handling of older versions of these files if
necessary.
The Navigator RIP can produce output in a variety of formats to suit various physical
output devices and file formats.
Similarly, there are options for output to many proofing printers and final output
devices. Each device, may have certain size limitations, as well as the ability to handle
colour (for proofing) or separations (for plate-making). In turn each of these devices
will have its own gain characteristic and require calibration.
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Once the RIP is installed, a one-of set up is required to create a “base” from which the
RIP will operate, and from time to time you may find it necessary to update or modify
the settings to suit your ever-changing requirements.

As there is a great deal to set up, Glunz & Jensen has created the config.ps file (found
in the C:\Program Files\Xitron Navigator7.1r0\Factory Defaults folder).
The file contains a “Basic Set-up” covering all the settings and calibrations required for
several plate sizes and can be loaded into the RIP upon start-up.

Printing the config.ps file installs all the items required for an initial set up of the RIP
including setting memory allocation, the RIP mode, buffers as well as some default
calibrations, tone curves, and page setups for plate-making.

Once these have been loaded and the RIP restarted, (and your unlock codes entered as
described in the previous section) you can use the following procedures outlined in
this section to assist you in editing the existing setups, duplicating them for the basis of 
new setups or creating new page setups and calibrations customized for your press.

Basic Concepts and Definitions

This section is intended as a guide to cover the basics required for operating the
Navigator RIP and to get you started.
For a much more detailed explanation of the RIP or each of these definitions please
consult the separate RIP User Manual located in your Manuals folder in the main RIP
folder.
Many of the main functions and items referred to in this chapter are briefly described
below:

• De vices: are es sen tially com bi na tions of a phys i cal printer, a soft ware screen
method, and printer-to-com puter con nec tion (i.e. USB).

• Sep a ra tion Styles: have to do with how sep a ra tions and com pos ite files are han dled
by the Nav i ga tor RIP. You can use a “Com pos ite” style to print com pos ite or
pre-sep a rated files, a “Sep a ra tions” style to sep a rate com pos ite files in the RIP (in -
clud ing lim ited trap ping), and a “Pro gres sive” style to pro duce pro gres sive proofs
from composite files.

• Page Set ups: are sets of in for ma tion re quired for print ing a plate, such as de vice,
res o lu tion, me dia size, cal i bra tion and tone curves, mar gins on the me dia, ro ta tion,
etc.

• Me dia Size: when mak ing a Page Setup this will be the size of your print ing plate
OR the size of the pa per used for mak ing proofs.

• Page Size: is the size of the Post Script or .pdf file that is sent from your pre-press ap -
pli ca tion. When you cre ate or edit a Page Setup, the de fault Page Size is ar bi trary.
The RIP will over ride that set ting with the size of the file you send to the Nav i ga tor
RIP.

• Cal i bra tion Curves: are used to linearize the out put of your Plate or proofer and to
add tone curves to your out put.
Print ing config.ps in stalls: PW2000_371/219 which is a Cal i bra tion Curve for Plate
Writer-2000 us ing Glunz & Jensen i-plates.
For proof ing we have en abled the RIP to sup port Epson 4800 and Epson 7800 print -
ers, within the Config di a logue box for each proof ing de vice are sev eral built-in cal i -
bra tion curves (shown with Green ticks) for var i ous Epson pa pers and inks.
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• Ac tual Press Curves: are used to linearize dot gain from the print ing press, or to em -
u late the char ac ter is tics of an other press.

• Print ing config.ps in stalls gen eral press curves which are press cal i bra tion curves for

linearising Glunz & Jensen i-plates on most com mer cial print ing presses.

• Please note that these are de fault curves. To achieve a more ac cu rate cal i bra tion, you 

may wish to cre ate your own curves.

• In tended Press Curves: are used to rebuild the de sired dot gain from the print ing
press, or to em u late the char ac ter is tics of an other press.

• Print ing config.ps in stalls In dus try stan dard: Com mer cial A, SWOP and Fogra
curves, 15%, 20% & 22% gain curves (plus oth ers) which are cal i bra tion curves used
to take the linearised Glunz & Jensen -plates where 10% will print as 10%, 30% as 30%
and 50% as 50% etc., which to many us ers (particularly with four col our work) will
cre ate flat-look ing im ages.

• The in tended press curves, ADD back the gain achieved with con ven tional half tones
(such as pro duced by plates made by film) on most com mer cial print ing presses.
Please note that these are de fault curves. To achieve a more ac cu rate cal i bra tion, you 
may wish to cre ate your own curves.

• Tone Curves: are used to ad just dot gain fur ther (they can be used to cre ate a cooler
look ing im age, or to cre ate more sat u rated im ages).

• No curves are in stalled with the config.ps, these can be gen er ated by the user.
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Setting Up Devices

• Make sure that the PlateWriter 2000 is on and con nected to your com puter.

• Start the Nav i ga tor RIP and se lect NavigatorRIP -> De vice Man ager from the ap pli -
ca tion menu.

• En sure the PlateWriter2000 ap pears in the Win dow. If it does not, then check that
you have en tered the pass word for the PlateWriter2000 cor rectly (in the Nav i ga tor-> 
ConfigureRIP -> Ex tras di a logue box - when re vis it ing the ConfigureRIP -> Ex tras
Win dow, the de vice Platewriter2000 should have the word YES next to it if the pass -
word en tered was correct).

• The De vice Man ager win dow lists the de vice types that are avail able for the
PlateWriter Plugin, PlateWriter2000.i32. The iCTP PlateWriter 2000 is the de fault
name for the PlateWriter Out put de vice and more op tions are avail able here. Se lect
2488 1 bit Dou ble (for PW based on Epson 4880). This win dow gives you the abil ity
to du pli cate or re name the de vice or add other de vices sup ported by the plugin.

• Based on ex pe ri ence with the PlateWriter 2000 and the Nav i ga tor RIP, we strongly
rec om mend to leave this un changed (whilst not need ing to change this de vice, you
may need to use this win dow to add proof ing items un der the iCTP plug-in).

Creating Separation and Progressive Styles

Separation Styles

A Separations Style is a definition used by the RIP to characterize how a file arriving
will be handled, how the colours will be separated out and what screening will be
used. There are many types of work flows used in the print environment to send files
to bureaus and to CTP equipment. One of the most popular is a pre-separated
workflow where users output their jobs in separations directly from the application.
There are others where users prefer to send composite jobs and allow the RIP to handle 
the separations. There can be circumstances where files arrive in a format where
incorrect colours have been used and you want the RIP to override the separations.
A more extensive explanation is found in Chapter 14 of the Xitron RIP Manual located
in your manuals folder in the RIP installation folder.
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Predefined Separations Styles

To make things easier, if you printed the config.ps file as described earlier, then it will
have already installed some separations styles for you.

• Se lect Color -> Sep a ra tions Man ager from the NavigatorRIP menu.

• This opens the Sep a ra tions Man ager win dow. Se lect iCTP PlateWriter2000 as the
de vice.

The pre de fined sep a ra tion styles ap pear in the list. They should cover all the sep a ra -
tion styles you need, so to cre ate or edit a Page Setup, turn to the sec tion ti tled Cre -
at ing Page Set ups for Plate Mak ing later in this sec tion.
How ever, if you did not print the config.ps file, fol low the pro ce dure as de scribed
be low to cre ate your own Sep a ra tion Styles.

Creating Separation Styles

• When open ing the Sep a ra tions Man ager win dow there will be a CMYK sep a ra tions
style and a mono chrome style al ready en tered.

Click on New.
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• The New Style... win dow opens.

• Give the new style a name that will be easy to re mem ber and re flects what your sep -
a ra tion style will achieve (e.g. Sep a ra tions (CMYK+Spot) to DEEDs2).

• Set Color space to CMYK.

• Set Out put for mat to Sep a ra tions.

• Click Cre ate to open the Edit Style di a logue.

• Choose which pro cess colours you want to print us ing the pop-up list.
We rec om mend us ing Not Blank rather than Yes or No. Not Blank means that the
sep a ra tion will be pro duced only if it is found in the com pos ite .ps or .pdf file.
If you se lect Yes, all sep a ra tions will be pro duced, even if they are blank. If you want 
SPOT colours to be printed, then set Other colours in job to Yes or Not Blank as
well.
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• If you re ceived jobs such as PDF’s from cus tom ers that con tain mul ti ple Spot and
CMYK colours, and you want to force the sep a ra tion to CMYK, then cre ate an ad di -
tional sep a ra tion style, set C, M, Y & K to Yes, then Other Col ors in job to No.

• Se lect whether to re ject or re com bine pre-sep a rated jobs. Pre-sep a rated jobs may
only be re com bined if the sep a ra tions come to the Nav i ga tor RIP in a single file.

• Now set the screen to be ap plied to the im age. Set the Dot shape to DEEDS2PW,
this is the Dy nam i cally Even – Ex tended Dif fused Screens that have been de signed
spe cif i cally for the PlateWriter.

• Check the Gen er ate ex tra gray lev els box, and set Limit num ber of dis tinct gray
lev els to 512.

• Click OK in the Edit Style di a logue.

• Now your style will ap pear in the list in the Sep a ra tions Man ager di a logue.

Click OK to save the changes.
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Creating Page Setups for Plate-making

About Page Setups

The Navigator RIP allows multiple page setups, each can be used to describe how to
handle a job that arrives at the RIP.
The page setup identifies which device will be used to output the file, which
separation style will be applied and thus the screening used to create the halftone.
It also describes the orientation and position of the job on the media, and finally the
actual media size itself.
Multiple page setups can be used for varying press sizes or orientations (such as
portrait presses or landscape presses) in a large print shop to allow plates to be made
for each press and position each plate correspondingly, or page setups can be used to
apply a different separation style if you get jobs from different sources, which have
been created differently. Any combination of the above can also be applied or even a
different output device such as a proofer.

Predefined Page Setups

To make things easier, if you printed the config.ps file as described earlier, then it will
have already installed some separations styles for you.

• Se lect Nav i ga tor -> Page Setup Man ager from the NavigatorRIP menu.
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• This opens the Page Setup Man ager win dow.

Here two dif fer ent press ori en ta tions and sizes are used, and in each case, two dif -
fer ent ways to han dle jobs ar riv ing have been de fined.
You can use these page set ups as they are or you can sim ply change them to meet
your re quire ments (such as larger plate size) or you can cre ate your own.
How ever, if you did not print the config.ps file to load the page set ups as de scribed
ear lier, then you will need to cre ate a page setup be fore you can use the RIP.
Fol low the pro ce dure as de scribed be low to cre ate your own page set ups if re quired, 
oth er wise for an eas ier way to change the ex ist ing Page Set ups loaded by the
config.ps file, see the sec tion “Du pli cat ing and Ed it ing a PageSetup” on page 4-22. 

Creating Page Setups

• Se lect Nav i ga tor -> Page Setup Man ager from the NavigatorRIP menu.
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• The Page Setup Man ager di a logue ap pears.

Click on New…

• The New Page Setup win dow opens.

• In the Out put De vice sec tion se lect the de vice PlateWriter2000 and check that the
val ues in the Res o lu tion sec tion change to 2880.

• Click on the Con fig ure De vice but ton in the Out put De vice sec tion.
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• The con fig u ra tion win dow for the PlateWriter 2000 opens.

• Make fol low ing set tings:
Set Uni-di rec tional

Don’t make any changes to the settings

• Click OK to con tinue.

• Note that the sym bols next to the Me dia names will show as red ex cla ma tion marks
un til the de vice is set up. Once you have saved these set tings and saved your Page
Setup, if you re turn to this di a logue box, you will see that these have changed to
green ticks as shown.

Operating Manual - PlateWriter
TM

 2000 0749

Using the RIP
4-11

Creating Page Setups for Plate-making



• In the Sep a ra tions, Screen ing & Color sec tion of the New Page Setup win dow
choose a Style – “Sep a ra tions (CMYK+Spot)” was the one we cre ated ear lier, or se -
lect it from the pre-de fined Sep a ra tions Styles loaded when print ing the config.ps
file.

• If you did not print the config.ps file, then leave the fields in the Cal i bra tion & Dot
Gain sec tion blank, and fol low the pro ce dure de scribed in “Cal i brat ing” later in this 

chap ter.

• If you did print the config.ps file then,
– Set Calibration to PW2000_371/219

This provides a linear output on the Plate

• Set Tone Curves to None
– Set Intended Press to Commercial A, or another curve that matches your request.

As CTP equipment is generally calibrated to provide a linear press sheet, this adds 
back the gain normally expected by conventional printing presses and thus creates 
a richer output for 4 colour work than a linear press sheet would.

– Set Actual Press to European Gain or another curve that matches your request.
– This linearizes the output on the press sheet, thus compensating for individual

press characteristics and the effect of the DEEDs screening.
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• The New Page Setup screen should now look like this (if the config.ps file was

printed, oth er wise each of the Cal i bra tion & Dot Gain items are set to None.

• In the Cas sette & Page sec tion click the Page Lay out.. but ton to open the Page Lay -
out win dow.

• Se lect units (inches or mm) for me dia size and mar gins. 
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Setting the Plate Size

• For print ing plates set the Me dia Width and Me dia Length to the width and length
of your print ing plates. Most plates will be im aged in por trait on PW2000. For ex am -
ple, for a Hei del berg SpeedMaster 52 set Width to 459 mm and Length to 525 mm.

• Make sure that the plate will fit on the printer in the ori en ta tion you are de fin ing.

• If the Page Setup is for proof ing set the Me dia Width and Me dia Length to the
width and length of your proof ing ma te rial. Note that this will gen er ally be a dif fer -
ent size than your print ing plates.
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Setting the Gripper and Job Position on the Plate

Not all of the plate can be reproduced. Furthermore, to reduce press make ready time,
it is desirable to place the job at the same starting point in terms of height, and in the
centre of the width of the plate. As all presses have an area at the top of the plate
where some of the plate is placed in the gripper, you should first establish where on
the plate you want your jobs to start. This is sometimes known as the Gripper Offset
or Top Margin.

Setting the Gripper and Job Position for Landscape Printing Presses

For Landscape presses, where the plate is printed in portrait, the PostScript or pdf-file
will generally be centred on the Media Length, and the Left Margin will be the
Gripper Margin plus the plate bend.
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Example of a Heidelberg SpeedMaster 52:

• The plate is loaded por trait (the long edge fits into the grip per).

• The plate size is 529 mm x 459 mm, so set the Me dia Width to 459 mm and set the
Me dia Length to 525 mm as shown above.

• Then check the Cen tre page on Me dia Length box (this places the job, ir re spec tive of 
size, in the cen tre of the plate Length) and en sure the Cen tre Page on Me dia Width
is not checked.

• Fi nally the Left Mar gin box will be avail able for you to en ter the po si tion that you
want the im age to start (the grip per mar gin) from the top plate edge to the start of
the job.

• Both the Top Mar gin and Bot tom Mar gin boxes will be greyed out, as the job will
au to mat i cally be cen tred by the RIP.

"
The Page Size in the bottom left of the dialogue box, will be overridden by the 
page size of the job being sent down from your application, so the value here
is not important, however we recommend that you set it at the largest job size
you are ever likely to send to this plate.
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• Click OK to re turn to the New Page Setup win dow.

Click the Save As... but ton.

• In the ap pear ing Save Setup di a logue…

...give your Page Setup a name which re flects the press size, and if nec es sary the
Sep a ra tions Style so it will be easy to se lect later. Click the Save button.
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• Click the OK but ton to exit the Page Setup Man ager.

"
If you click “Cancel” at any point, including to exit the Page Setup Manager
above, then any changes you made or new Page Setups will be lost!

Setting the Gripper and Job position for Portrait Printing Presses

For Portrait presses, the PostScript or pdf file in theory should be centred on the
Media Width, and the Top Margin should be set equal to the gripper margin plus the
plate bend.

If your plate size allows it, in many cases it will be quicker for the PW2000 to print the
plate in Landscape orientation due to the fact that the plate has less far to advance.
In this case, the PostScript or pdf file should be set to centred on the shortened Media
Length, and the Left Margin will be set to the gripper plus the plate bend on the
printing press.
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• Ex am ple of an Hei del berg QM46 press:

• The plate size is 340 mm x 505 mm, and nor mally the nar row edge (340 mm edge)
would be the grip and so would nor mally be the top.

• Set the Me dia Width to a plate length of 340 mm and set the Me dia Length to a
plate width of 505 mm as shown above.

• Check the Cen tre page on Me dia Width box (this places the job, ir re spec tive of size,
in the cen tre of the plate width) and en sure the Cen tre Page on Me dia Length is not
checked.

• Fi nally the Top Mar gin box will be avail able for you to en ter the grip per plus the
plate bend on the print ing press.

• Both the Left Mar gin and Right Mar gin boxes will be greyed out, as the job will au -
to mat i cally be cen tred by the RIP.
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• Click OK to re turn to the New Page Setup win dow.

• In the Ef fects sec tion set Ro tate to the re quired ro ta tion that matches de pend ing on
the Post Script or pdf file and if you have a por trait or land scape press. 

• Click the Save As... but ton.
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• In the ap pear ing Save Setup di a logue…

...give your Page Setup a name which re flects the press size and if nec es sary the
Sep a ra tions Style so it will be easy to se lect later.

• Click the Save button.

• In the Page Setup Man ager di a logue...

...click the OK but ton to exit.

"
If you click “Cancel” at any point including to exit the Page Setup Manager
above, then any changes you made or new Page Setups will be lost!
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Duplicating and Editing existing Page Setups

Overview

One of the easiest ways to create new page setups is to duplicate an existing one and
change the items you require. The most common requirement is to create Page Setups
that match different presses and plate sizes.

In addition to this, you may wish to create a duplicate of an existing Page Setup to
handle jobs created by different sources differently.

For example, one workflow/customer may always supply the jobs rotated by 90° and
so you can create a duplicate Page Setup, simply with the Rotation Page effect
switched on to correct this.

Alternatively, one workflow/customer may supply jobs separated, another may
supply jobs pre-separated. Again, duplicating the Page Setup and simply selecting
different separation styles for each Page Setup easily solves this problem.

Finally, you may find from time to time, you receive jobs that have been badly
constructed, and contain CMYK process inks and multiple spot colour inks. Here again 
you can edit the Page Setup to override the separation styles to force all colours to
CMYK.

"
Editing a PageSetup is easy, but remember that it will alter the Page Setup you 
choose to edit. We recommend that you duplicate/copy the Page Setup you
want to base your new PageSetup upon, then change this duplicate and leave
the original Page Setup untouched.

Using “Copy” to Create a PageSetup for a different Plate Size

• Se lect Nav i ga tor -> Page Setup Man ager from the NavigatorRIP menu.
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"
If you already have a Press Setup created, and you wish to add another of a
different size, then try to select a Setup with the same orientation (e.g. if you
have a Portrait Press setup such as an Heidelberg QM46 and want to create a
different size such as a ABDICK 9810) and copy this Page Setup. This will
make creating the Page Setup much quicker as the only items to change will be 
the Plate Size and the PageSetup Name.
Even if you do not have the correct Press orientation already created, it will
still be much quicker than creating a New Page Setup, however you will need
to check you have centred the image on the height (for Landscape) or the
length of the page (for rotated Portrait) appropriately (see section on creating
Page Setups).

• In this ex am ple we will add a Hei del berg SM52 press (459 mm x 525 mm) to our
Page Setup list by copy ing and ed it ing the Hei del berg SM GTO52 Page Setup.

• From the list in the Page Setup Man ager di a logue…

...se lect the Page Setup you wish to base your new Page Setup upon, in this case se -
lect the GTO 52 Pre-Sep a rated Page Setup and click Copy... to cre ate a du pli cate
Page Setup.
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• The New Page Setup win dow will ap pear.

Click on the Page lay out... but ton.

• In the Page Lay out di a logue…

..edit the ex ist ing Me dia Width and Me dia Length set tings to re flect the plate size of 
your new press page setup.
In this case plate width is 459 mm and plate length is 525 mm.
Set the new Left Mar gin if this press has a dif fer ent Grip per re quire ment.
Click OK.
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• You will be re turned to the New Page Setup win dow.

Click Save As... to save your new Page Setup with the new plate size.

• Give your new Page Setup a name to re flect the set ting you have se lected.

In this ex am ple name the Setup SM52 In_RIP Sep a ra tions. Click Save.
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• In the Page Setup Man ager di a logue...

...ver ify that your new Page Setup ap pears in the list.
Click OK to exit.

"
If you click “Cancel” at any point including to exit the Page Setup Manager
above, then any changes you made or new Page Setups will be lost!

• You have now com pleted cre at ing your new Press Page Setup.
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Printing a Job Using the RIP

Using the Print File Command

When you select Print File from the Navigator RIP menu, the dialogue box shown
below appears.

Ensure you choose an appropriate Page Setup for printing the files, from the Page
Setup drop-down list.

"
If you do not choose a Page Setup, the RIP uses the one that you chose last
time you printed a file. If you have not printed a file in this RIP session, the
first Page Setup in the drop-down list is used. To change the order of this
listing, simply drag the PageSetup you want at the top of the list into that
position in the PageSetup Manager. See full RIP manual page 118 for further
details.

The Print File dialogue box shows all PostScript-language and PDF files in the current
folder. To show files of a different type, or all files, use the Files of type drop-down
list.

If you want to choose a file that is not in the folder shown, use the dialogue box to
navigate to the correct folder.

"
To select all files in the list, click anywhere in the central list of files and type
Ctrl+A.

While any file is being processed, an additional Print File menu appears on the menu
bar of the main RIP window.

You can abort the current job by choosing Kill Current Job from this menu, or by
typing Alt+ (a period character).

When Kill Current Job is selected, the current job is stopped, but subsequent jobs will
be processed.

By selecting Stop Printing File, the current file will complete, but any jobs queued
after the current job will not print.

Selecting Abort Printing File will stop the current job and also stop all subsequently
queued jobs from ripping.
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Printing several files

To print out several files at once, just select more than one file from the Print File
dialogue box before clicking Print.

The following keys make this possible:

You can select a contiguous block of files by selecting the first file in the block, then
selecting the last file in the block while holding down the Shift key.

You can select several non-contiguous file names by holding down the Ctrl key while
making your selection.

"
The list of files to print can include files other than PostScript-language, PDF
files, TIFF 6.0, and TIFF/IT-P 1. The RIP ignores types of files that it cannot
print.
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Automating Job Input to the RIP

Printing using Managed Input Plug-ins or 'Input Queues'

This section describes the different ways in which the Navigator RIP can accept input,
and how to configure the RIP to use each type of input.
 
There are several ways of providing input to the Navigator RIP:

• Us ing the Print File menu com mand, as de scribed pre vi ously.
This com mand al lows a user on the ma chine run ning the RIP to print all of the job
types pos si ble on that in stal la tion of the RIP. You can use Print File while man aged
in puts are active.

• Us ing one or more man aged in puts, as de scribed be low, and the fol low ing sec tions.
This is the pre ferred method for rou tine use be cause, in gen eral, the man aged in puts 
al low us ers on many ma chines to sub mit jobs to the RIP.

When you use managed inputs or the Print File menu command, you can print several 
types of job.

The possible types, are:

• Post Script-lan guage files (PS) and En cap su lated Post Script files (EPS)

• Por ta ble Doc u ment For mat (PDF) files.

• JPEG and JFIF files.

• TIFF/IT-P1 files.

• TIFF 6.0 files.

In the same way that the RIP uses output plugins to provide output sources such as the 
PlateMaker or Proofer, it uses Input Plug-ins to provide managed input sources.

There are a number of input plug-ins supplied with the RIP, each providing you with
the ability to submit jobs under different situations.
The full Xitron RIP manual describes all of these plug-ins, and the way in which you
can manage the inputs they provide. This manual only covers the most frequently used 
plug-ins, what they do and how to set them up.

The most commonly used inputs are:

• Spool Folder (also known as Hot Fold ers, or watched fold ers)

This lets you specify multiple independent folders into which users or applications
can place jobs to be printed. The RIP checks for the presence of files in these folders
and prints each one automatically.

"
Folders can be shared across a network, however Apple Users will only be able 
to see PC networks if the Network has been configured with the additional
ExtremeZ-IP protocol provided or with SERVER based applications. The
Normal mode of connection for Apple users is to use the AppleTalk plug-in
detailed below.
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• AppleTalk

This publishes PageSetups in the RIP as a printer(s) on AppleTalk networks and lets
the RIP accept input from any Mac application that prints to the printer(s) broadcast
by the RIP.

• NT Print

This publishes the RIP as a printer available to the Windows NT print services, this
printer can then be shared to other PC users in a similar fashion to the AppleTalk
plug-in for Mac users.

Each of these plug-ins can have multiple configurations, each configuration is given a
unique name, then the input derived from the queue is linked to a specified Page
Setup, so the RIP can print the file. This enables multiple Inputs from different sources
for each page setup, and/or one input plug-in to receive jobs for multiple Page Setups.

Example: A print queue may be set up watching a specific folder (using the Spool
input plug-in), any files sent to this folder will be delivered to the page setup
associated with this print queue (such as PageSetup 1).

At the same time, an addition queue may be active, using the AppleTalk input
plug-in, a print queue can be created which broadcasts a “virtual” printer on an
Apple Network. Any jobs printed by a Mac user will be delivered to the page setup
associated with this Print Queue (which could also for this example be PageSetup1).

Therefore, in this scenario the RIP allows different inputs (both AppleTalk and
SpoolFolders) to send jobs to the RIP and will automatically accept and handle them as 
they arrive.

Alternatively: A Print queue may be set up watching a specific folder (e.g. folder
QM46) using the spool input plug-in, any files sent to this folder will be delivered to
the page setup associated with this print queue (such as a PageSetup for the
Heidelberg QM46 press).

At the same time, an addition queue may be set up watching a different specific
folder (e.g. folder GTO52) using the spool input plug-in, any files sent to this folder
will be delivered to the page setup associated with this print queue (such as a
PageSetup for a Heidelberg GTO52 press).

Therefore, in this scenario the RIP allows multiple folders to be published on a
network, and users can drag and drop jobs/files into the folder relating to the
appropriate page setup. The most common example of this is to accept jobs for
different press sizes, so the RIP can orientate the job for each press, set the grip
position and then output the job.
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Managing Input Plugins

You control input plugins using the Input Controller. Before creating new inputs or
changing existing ones, check that you have an appropriate page setup which can be
associated with each input.

• Open the In put Con trol ler di a logue box ei ther by choos ing the NavigatorRIP -> In -
put Con trol ler menu op tion or by click ing the tool bar but ton.

• The fol low ing In put Con trol ler di a logue box will ap pear.

The In put Con trol ler di a logue box shows the in put sources cur rently avail able. Each
in put source can be turned on or off in di vid u ally us ing the but tons— the state is dis -
played in the Sta tus col umn.

Each row in the list rep re sents one par tic u lar source, and contains:
– The Name for the input source. This is used to identify the source within the RIP.

It may also be used by the input plugin itself.
– The Type of input. This determines which input plugin the RIP uses.
– The Page Setup. This is the page setup used by all jobs arriving through this

source.
– The Enabled state. This should be On to make the source available when you start 

the RIP or start inputs.
– The Status. This can be Stopped, Idle, or Busy.

An input is stopped either because all inputs are stopped, because you have disabled 
this input in the Input Controller (using Off), or because of a problem when trying
to start that input. An idle input is ready to receive a job but none is arriving. A busy 
input is actually receiving a job.

Below the list of sources are several buttons that allow you to perform the various
actions enabling you to create, copy or delete managed inputs.

When you have finished making changes in the Input Controller, you can keep it
visible as a way of monitoring which inputs are submitting jobs or close it either by
using the Navigator RIP -> Input Controller menu option or by clicking the tool bar 
button.
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Turning on the input system

To start receiving jobs from the configured and enabled inputs, choose the
NavigatorRIP -> Input Controller menu option or clicking the tool bar button.

The tool bar button is the most frequently used way to start or stop the queues, and
simply uses icons representing Traffic Lights.

Click the Green Traffic Light to start the queues, and the Red Traffic Light to stop the
queues.

"
When you start the Queues, there is a delay of a few seconds as the various
defined input sources are initialized, and then the RIP starts to accept jobs
from those sources.

The status area of the tool bar shows the searching for input symbol (a torch or
flashlight shining on an arrow).

A new menu appears in the menu bar, called Input Queue.

This menu has these options:

• Kill Cur rent Job: This causes the job cur rently pro cess ing to be aborted. It may take
a few sec onds.

• Stop In put Queue: This turns off the in put sys tem when the job cur rently pro cess -
ing has fin ished.

• Abort In put Queue: This aborts the job cur rently pro cess ing and then turns off the
in put sys tem.

Adding a new input source to the list

You can create many different input sources for each input plugin. For example, you
could create 5 spool folder input sources and 10 AppleTalk input sources.

To add a new input source to the list:

• Click the New but ton in the In put Con trol ler win dow. The RIP dis plays an In put
Chan nel Edit di a logue box, al low ing you to fill in the de tails for this source.
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• Type a name for the In put plugin de vice in the Name text box.

"
The name is used to identify the source within the RIP. It may also be used
by the input plugin itself. If you create an AppleTalk input device, when
you start the inputs a ‘virtual printer’ with this name becomes available on
the AppleTalk network. Try to use names that allow you to identify which
PageSetup the jobs will be sent to.

• Choose the plugin type from the Type drop-down list. (e.g. AppleTalk, or Spool
Folder)

• Choose a saved page setup from the Page Setup drop-down list. The RIP ap plies
this page setup to each job ar riv ing at the source.

• If the plugin is to be ini tially turned on, se lect the En abled check box.

• Click the Con fig ure but ton to dis play an In put Plugin Con fig u ra tion di a logue box,
al low ing you to spec ify de tails rel e vant to the in put plugin you have cho sen.
The Con fig u ra tion di a logue box var ies ac cord ing to the type of plugin cho sen. It is
used to give de tails about how the in put is to be han dled, e.g. for Spool Fold ers, it
tells the RIP which folder to watch for jobs. See be low for the con fig u ra tion and use
of this box.

• When you have spec i fied all the de tails for the new source, click OK.

Copying an input plugin

When you have created an input plugin, you can copy it to create other inputs of a
similar type. This can save you some effort, depending on the complexity of the
Configuration dialogue box.
To copy an existing input, select the entry in the Input Controller and click the Copy
button.
You must give the copied input a new name and you will probably need to alter some
details in the Configuration dialogue box. For example, only one active input can use a 
particular spool folder or network input at one time - but you can have two or more
inputs using the same source, provided that you enable only one at a time.

Editing the details for an input source

To edit the details for an existing input source, do one of the following:

• Se lect the en try in the In put Con trol ler and click the Edit but ton.

• Dou ble-click the en try in the In put Con trol ler.

The RIP displays an Input Channel Edit dialogue box, allowing you to edit the details
for the selected plugin. 
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Configuring an input plugin

Configuring an input means giving details about how the input is to be handled, and
setting up any hardware or software associated with the source. To configure an
existing input plugin, select it in the Input Controller and click Edit.
The RIP displays the Input Channel Edit dialogue box. Click Configure to see the
Configuration dialogue box for the selected input. 

Deleting an input source

To delete an input source from the RIP, select it in the Input Controller and click the
Delete button. You can select multiple inputs and delete them in one action.

Enabling and disabling input sources

To enable an input source, select it in the Input Controller and click the On button.
To disable a source, select it and click the Off button.
Using these buttons has the same effect as selecting or clearing the Enabled check box
in the relevant Input Channel Edit dialogue box.

When the selected input source is enabled, then the On button is disabled, and when it 
is not enabled then the Off button is disabled.

You can select several input sources and then turn them on or off together.
When an input plugin is enabled, the RIP automatically publishes it when starting
input queues, meaning that the input plugin can be used to send jobs to the RIP.
To make enabled inputs active, choose NavigatorRIP -> Start Inputs or click the
Green Traffic Light tool bar button. 
To stop all enabled inputs, choose NavigatorRIP -> Start Inputs again or click the Red
Traffic Light tool bar button.
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Using the Spool Folder Input folder

The spool folder input is the most popular managed input for PC users. The Spool
plug-in regularly scans a specified disk folder (directory), and processes any
PostScript-language files (and other suitable files) that are placed there. Normally these 
files are deleted after successful processing. The spool folder can be on a network file
server, or the local iCtP RIP Workstation. Users create files from their applications.
These applications can create the files directly in the spool folder, or can create them
elsewhere (for example, on the local system) for later transfer into the spool folder.

The RIP can process some or all of the following file types using a spool folder:

• Post-Script-lan guage (PS)

• En cap su lated Post Script (EPS)

• Por ta ble Doc u ment For mat (PDF)

• TIFF 6.0

• JPEG and JFIF files

The RIP ignores types of files that it cannot print, and any files that you exclude
intentionally by configuring the spool folder input.

You can exclude files based on their names. You may want to exclude files that
resemble real jobs, but that actually contain accounting or housekeeping information
for the software that delivers files into the spool folder. You may also want to exclude,
or at least delay, real jobs with particular origins or qualities. All this is possible so long 
as the file names have a recognizable prefix.

You specify which folder the RIP uses in the input plugin Configure dialogue box,
available from the Input Controller. If needed, you can create several spooled inputs,
each with its own folder, page setup, and exclusion list.

When you specify a folder accessed over a network, make sure that the folder
automatically becomes available to the computer running the RIP when that computer
is restarted. Because files are normally deleted as soon as they are printed, it is
important to ensure that the RIP has permission to delete files in the spool folder,
particularly if the spool folder is on a network file server.

The files in the spool folders are processed in the order in which they arrive. However,
if there are jobs already in a folder when the RIP is started, or if a very large number of
files have been queued, the RIP determines the order of those jobs by the date stamps
on the files.
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Creating and Configuring a Spool Folder Input Source 

To create and configure a new spool folder source do the following:

• Open the In put Con trol ler di a logue box ei ther by choos ing the NavigatorRIP -> In -
put Con trol ler menu op tion or by click ing the tool bar but ton.

• The In put Con trol ler di a logue box will ap pear.

Click New

• The RIP dis plays the In put Chan nel Edit di a logue box.

• Choose SpoolFolder from the Type drop-down list.
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• Se lect the Page Setup you wish to re ceive and pro cess jobs that ar rive in the spool
folder (here we have se lected the GTO52 Pre-Sep a rated Page Setup).

• Give your in put queue a Name (try to use names that re flect the PageSetup you are
send ing it to, to make ed it ing queues later a lit tle eas ier).

• Click on the Con fig ure but ton to open the Spool Folder Con fig u ra tion win dow.
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• The Spool Folder Con fig u ra tion win dow con tains the fol low ing con trol items:

Spool Folder
The current spool folder is shown in the text field beside this button. This location is
where the RIP detects the arrival of files and considers them as possible jobs, by
looking at the type of file and any file names excluded in the Filenames pre-fix list.

"
Choose a folder that is dedicated to receiving jobs. In particular, avoid using 
folders where other files are arriving or changing (for example, the SW
folder is a bad choice, because the log file changes with every job).

Click the Spool Folder button to change this folder using the standard file browsing
dialogue box.

"
Alternatively you can type a full path name in the text field, but be aware
that any typing errors can cause an error or the creation of a new folder.

We recommend that you create a folder called Jobs, and in there create folders for
each Press and Plate Setup you have created as Page Setups.

In this example, as we have created a Spool Folder queue that sends jobs to the
GTO52 Pre-Separated Page Setup, we have named the folder the same, so when you 
drop the files into the folder you will know which Page Setup will be applied to the
job.

Create spool folders if they do not exist:

Select this box if you want the RIP to create the named spool folders if they do not
already exist.
The RIP creates the folders when the input channel becomes available for use. This
time can be immediately after you click OK in the Input Channel Edit dialogue box
for an enabled channel, but you may need to choose NavigatorRIP -> Start Inputs
or enable the input channel before it becomes fully available.

Warn if spool folders do not exist
Select this box if you want the RIP to issue a warning if a folder named as a spool,
error, or completion folder does not exist.
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Error Folder
If a file fails to print, the RIP moves it to the error folder specified unless the Delete
on error box is selected. If a file prints successfully, the RIP moves it to the Complete 
Folder specified unless the Delete on completion box is selected.
Again, we recommend you change the default here to a folder called Error inside
your main Jobs folder.

Delete on error
Select this box if you want the RIP to delete files that the Spool folder fails to print.
Leave this box clear if you want failed files to be moved to the Error folder.

"
We recommend you do not check this box, so that you can check which files
create an error, then you can take at look at them to determine why.

Note that a file is treated as an error if you abort it while it is being processed.

Move/Delete All Files
With this option selected the spool plugin will either move to the Error folder, or
delete any file which it does not recognize (such as badly formed PDF documents).
The files are moved or deleted depending on the state of the Delete on error check
box.

$
If you de cide to use this op tion and you in ad ver tently choose to point the
spool folder at a di rec tory con tain ing im por tant files (such as C: \win -
dows… or your SW folder) you will re move all files in this folder, re sult ing
in ei ther a non-func tional com puter or non-func tional ap pli ca tions. The
plugin de letes or moves all the files it cannot handle.

Move/Delete Valid Files
In this case, if a file is encountered which the spool plugin does not recognize, it will
leave the file in the spool folder and ignore it. Valid files which cause an error will be 
treated according to the setting of the Delete on error check box.

Complete Folder
If a file successfully prints, the RIP moves it to the location specified in the text field
beside this button unless the Delete on completion box is checked.
Click the Complete Folder button to change this location using the standard file
browsing dialogue box.
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Delete on completion
Select this box if you want the RIP to delete files that the spool folder succeeds in
printing. Otherwise the RIP moves these files to the Complete folder.

"
Generally we recommend deleting jobs after printing successfully.
However, there are circumstances where this is useful, such as moving the
job into another folder for RIPPing, like the Proofing folder. So you can
supply Plates and Proofs at the same time from the same file.

Filenames prefix list
This text field specifies files to ignore when they arrive in the spool folder, if you
have also selected the Exclude prefix list box. The specification is based on the first
part or prefix of the file names. Prefixes are case sensitive. 

You can enter several prefixes. Separate multiple prefixes by commas without
surrounding spaces. If you add spaces after a comma, the RIP treats the spaces as
part of the following string. Each prefix can include alphanumeric characters, the
underscore character, the period character, and spaces. 

For example, this is a valid list of three prefixes: aaab_c, BAC, 4.4

Exclude prefix list
Check this box to make the prefix list active. Leave this box empty to disable the
prefix list without deleting the list of prefixes.

Scan spool folder every <n> seconds
The value in the text box specifies how often the RIP checks the Spool folder for new
files to be printed.

Time to wait for file to stabilize <n> seconds
The value in the text box specifies the number of seconds that the Spool folder waits
for the size of an arriving file to remain the same before assuming that it has been
fully written and is therefore ready to be printed.

Suppress startup warnings
If you have files present in the spool folder and then start the RIP, you will be
prompted with a warning that files already exist in this folder which you must
acknowledge before the RIP will start. If you would prefer to suppress these startup
warning messages and continue to start the RIP, select this option. All files present
in the folder will be processed.

• Hav ing set all the con fig u ra tion op tions click OK. Your In put Queue is now ready to 
use. If you have now set all the queues up and want to ac ti vate them, click the Green 
Traf fic Light but ton on the tool bar to start your queues.

"
If you want to set up multiple queues based upon different page setups,
select the Spool Folder queue that you have just set up, then use the “Copy”
button at the bottom of the Input Manager dialogue box. Then give your
copied input queue a different name, select the new page setup which you
wish to send the jobs to, then click “Configure”. Now you only need to
change the “Spool” folder, to reflect a new folder to act as the source for
your new queue.
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Using the AppleTalk Input Plugin

With the AppleTalk Plugin, the user defines a name and defines a Page Setup from the
RIP to associate to that name (Queue). The name (Queue) is then published by the
AppleTalk input source over the Apple network. This name (queue) appears in the
Chooser on Macintosh computers connected to the network very much like a Laser
Printer (so, in effect the Name/Queue is a virtual printer hosted by the RIP).
When Mac users select this name (Queue) they can then install the “virtual printer”
hosted by the RIP, just as they would a LaserPrinter. Users can create multiple Queues, 
each associated with different Page Setups. So, the Chooser will see multiple
“printers”. After this users simply select the Printer relating to the Page Setup they
wish to send jobs to and then print directly from the application they are using.
When jobs arrive from the Mac, the RIP detects which “virtual printer” they were sent
to, applies the associated Page Setup and processes the job accordingly.

Configuring an AppleTalk input source

• To cre ate an AppleTalk in put source, se lect the source in the In put Con trol ler and
click New. The RIP dis plays the In put Chan nel Edit di a logue box.

En ter a Name for your Queue.

"
As this name will be broadcast over the AppleNet work to identify your
queue (and will essentially appear as a printer in the chooser) select a name
that clearly identifies the Page Setup the job will be sent to.

For example for the Page Setup GTO 52 Pre-Separated you could set the Name to
“Plates for Heidelberg”. Or if you have a proofer, you could set the Name to Proofer.
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• Af ter you have en tered the name, se lect AppleTalk from the drop down menu in
the Type box.

The AppleTalk Input Plugin is one of the simplest to set up, and there is nothing that
needs to be configured for this plugin, so you can now click OK and the plugin is
ready to use.
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Using the NT Print input

This input publishes the RIP as one or more printers available to the Windows NT,
2000, and XP print services. Once fully installed and configured, each printer has a
name visible to Windows operating systems.

There are several stages to installation and configuration, which you must carry out in
the following order:

• In stall ing the plugin

• Con fig ur ing the RIP to make the in put avail able

• Con fig ur ing Win dows to as so ci ate a printer with the RIP in put

Installing the plugin

When your RIP was installed, the installer placed the NT Print plugin install wizard in
the C:\Program Files\Xitron_7.1r0\NTPrint folder.

Use the Installation Wizard as described below:

• Exit all run ning ap pli ca tions

• Run the file Setup.exe found in the \Ntprint folder

• When the in stal la tion pro gram asks you, choose the folder in which the Nav i ga tor
RIP is in stalled
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• Click on Browse and se lect the folder where your RIP is in stalled.

This should be C:\Pro gram Files\Xitron_7.1r0.
Click OK

• Wait for the in stal la tion pro cess to fin ish…

...then re boot the com puter.

Creating an NT Print Input

Having installed the plugin as described above, you can create a Navigator RIP input.

• Click New in the In put Con trol ler. The In put Chan nel Edit di a logue box ap pears.

Give the in put a suit able name.
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• Choose NT In put from the Type drop-down list.

• Se lect a Page Setup then check the En abled box.

• Click the Con fig ure but ton. The NT Print Con fig u ra tion di a logue box ap pears. 

The di a logue box con tains con trols to al low for the sit u a tion where RIP in puts have
started up be fore the Win dows spooler sys tem - this is pos si ble on fast ma chines.
The de fault is to ac cept fail ure, in which case the printer will be un avail able with out
user in ter ven tion. You can make the RIP keep try ing, within a time limit, by us ing
the con trols.

En able
Se lect this box if you want the RIP to re try mak ing a con nec tion to the Win dows
spooler af ter ini tially fail ing.

Re try de lay
En ter the time, af ter the ini tial fail ure, for which you wish the RIP to con tinue re try -
ing. A re try de lay of 60 sec onds is likely to be enough on all ma chines. Too long a
de lay means de lay ing jobs on other inputs, so reduce this figure if you have no
problems.

• Click OK to close the NT Print Con fig u ra tion win dow.

• Click OK in the In put Chan nel Edit di a logue box to close it.

• Use Nav i ga tor RIP -> Start In puts to start in puts (or the Green Traf fic Light icon on 
the toolbar).

You now have a RIP channel that forms a port visible to the Windows printer
configuration software. Next you must add a printer under Windows XP.
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Creating a Printer under Windows XP

You have two options. Either you can create a new printer to use the RIP channel, or
you can connect an existing printer to the RIP channel. The procedures are similar for
Windows XP and Windows 2000.

To create a printer for Windows XP:

• Us ing the NavigatorRIP -> In put Con trol ler, cre ate and start a new in put chan nel of 
the type NT In put as de scribed ear lier in “Cre at ing an NT Print In put”.

• In Win dows, from the Start menu se lect Set tings -> Print ers and se lect Add Printer.
The Add Printer Wiz ard ap pears.

Click on Next.

• Se lect Lo cal printer at tached to this com puter and en sure that the Au to mat i cally
de tect and in stall my Plug and Play printer check box is not checked.

Click Next.
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• Se lect Cre ate a new port and se lect ScriptWorks from the drop down se lec tion box
(this is the in put added to Win dows by the Har le quin RIP).
Click on Next.

A list box is then dis played show ing the names of all un con nected ScriptWorks
Chan nels (that is the name of any in put you have cre ated us ing the NTPrint Plugin).
Se lect one of these and click OK.

• Con fig ure the printer. To do this you need to in stall the printer driver for the
PlateWriter2000 sup plied on the PW2000 In staller CD.

Click Have Disk…
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• In sert the PW2000 In staller CD ROM. Open the Win dows Post script Driver folder.

Se lect the iCTP_Win2K-XP.INF file and click Open.

• Click OK.

• The iCTP Post script Driver will be dis played.

Se lect it, then click Next.
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• Now you must give your printer a name. By de fault Win dows will use the iCTP
Post script driver name, how ever you will want to choose a name, to re flect which
Page Setup the jobs will be de liv ered to for us ers us ing this queue.

Name the printer (we sug gest you use the PageSetup name or some thing close to it).
Click Next.

• Choose whether or not to share the printer (for other Net work us ers to see) giv ing it
a shared name if you do share it.

Click Next.
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• Win dows will ask you if you want to print a test page.

This is not nec es sary, so se lect No and click Next.

• Fi nally, you will see a Com ple tion screen sum ma riz ing the de tails fo the printer you
have added.

Click Fin ish.

• Win dows will copy over the files it needs from the CD ROM.

• In stal la tion is com plete. 
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If you later want to reassign the printer to another port, do this:

• Choose the menu op tion Start -> Set tings -> Print ers.

• In the Print ers win dow, se lect the printer, right-click and choose Prop er ties.

• In the Prop er ties win dow, click the Ports tab. Choose a new port by se lect ing its box
in the list of ports.

• Click OK to con firm the changes.

Using the Printer from Windows 2000/XP

The new printer is now connected to the RIP. Any printer output sent to the new
printer will be routed to the RIP.
The Windows spooler will remember the names of the printers between reboots of the
computer running the Navigator RIP. 

#
If an attempt is made to send a file to a printer attached to a RIP channel that is 
not currently running (i.e. you have launched the RIP but forgotten to start the
Channels) a warning is displayed in Windows that the port is not available
and the user is given the chance to retry the job.
If this occurs, if you start the RIP input channel before the user retries the job,
the job will restart successfully.

Using More than One Method

The RIP can use any combination of the above input types and listen on all active
inputs. When several inputs want to send data, only one job can reach the RIP at a time 
but the other inputs may be able to receive and buffer data for later rendering.
To accept input from several sources, create and enable the sources you want in the
Input Controller. The RIP automatically monitor all enabled sources as soon as the
input system is started with the Start Inputs menu option.

Enhanced File Management and Printing for Mac Users

To further enhance the printing options for Mac Users, an additional application is
supplied, called ExtremeZ-IP.
This installer is automatically copied into your AppleTalk folder in the RIP folder,
during installation.
For details of the ExtremeZ-IP application please refer to the Manual supplied in this
folder.
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Calibrating

Why Calibrate

The function of Calibration Curves is to linearize output on your plates. There are
several approaches on the use of the remaining curves. Generally, if you use the actual
press calibration curve to linearize your press then you will be printing with linear
plates that will produce flat images. For some users this will be the desirable effect, as
a 10% tint on screen will reproduce a 10% tint on the printed sheet; this is preferable
for spot colour users.

However, in CMYK (4 colour process) work, the flat image created by a linear output
will give a dull uninteresting image. In these cases use of the Intended Press curve or
tone curves will provide the needed correction and are used to “put back”  the dot gain 
that is assumed in the pre-press process.

Although the calibrations that we include in the RIP installation process are reasonable 
starting points, you may find that it will be necessary to create calibration curves for
your press, papers, and inks to produce high quality printed results.

Using Calibration to Linearize Output on Your Plates

"
It is necessary to have an existing Page Setup to use this calibration procedure.
Follow the instructions in this document to create you own Page Setup or
apply the calibration procedure to one of the standard Page Setups created
during RIP installation by printing the config.ps file.

• Start the Nav i ga tor RIP.

• If nec es sary, open the Out put Con trol ler / Mon i tor win dow by ei ther press ing
Ctrl+O or choos ing Out put -> Out put Con trol ler from the RIP menu.

• Be sure that Dis able Out put is checked. This will al low you to con trol the start of
print ing in the next steps.
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• Choose Out put -> Print Cal i bra tion from the RIP menu.

• Choose a page setup and click on Print uncalibrated tar get. The cal i bra tion tar get
will be ripped and writ ten to disk.

• Load a plate onto the PlateWriter's Align ment Mat and move it to the READY-po si -
tion as de scribed in “Load ing Plates” ear lier in this man ual.

• Press and hold the [SETUP] key on the Con trol Panel for 1 sec.

• In the Out put Con trol ler/Mon i tor win dow se lect Uncalibrated tar get in the Ac tive
Queue.
Click on the Info but ton to open the Through Put Info di a logue.
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• Click on Page lay out....

• Check that the Me dia Width, Me dia Length and Mar gins are cor rect for your plate.
(The cal i bra tion tar get is pretty small, but you should check to en sure the mar gins
will put it in side your print ing area).

• Uncheck Dis able Out put in the Out put Con trol ler / Mon i tor win dow.
A tar get sim i lar to this il lus tra tion will be printed.

• Af ter the tar get has printed, re move the plate from the PlateWriter.

• Place the plate on the front of the PlateWriter's Fin ish ing Unit. 

• Use a high qual ity re flec tion den si tom e ter ca pa ble of read ing sto chas tic dots, or
com pa ra ble de vice, to mea sure the dot% for each of the patches on the printed cal i -
bra tion target.

0749 Operating Manual - PlateWriter
TM

 2000

Using the RIP
4-54

Calibrating



• Choose Out put -> Cal i bra tion Man ager from the RIP menu.

• Choose the same De vice type as was used to print the tar get.

• Se lect Mono chrome as the Col our Space.

• Click on New....

• Name the new cal i bra tion and en ter the mod i fied col umn of Dot% mea sure ments in
the edit boxes. You may Smooth the data af ter it is entered.

• Click on OK in this win dow and in the Cal i bra tion Man ager win dow to save your
pro file.

Operating Manual - PlateWriter
TM

 2000 0749

Using the RIP
4-55

Calibrating



Including the Linear Calibration in Page Setups

Editing the Page Setups

• Choose Nav i ga tor -> Page Setup Man ager from the RIP menu to open the Page
Setup Man ager win dow.

• Se lect the Page Setup that was used when print ing the uncalibrated tar get and click
on Edit to open the Edit Page Setup di a logue.

• In the Cal i bra tion & Dot Gain sec tion se lect the Cal i bra tion you just cre ated.

• Leave the Tone Curve set to (None).

• Save the ed ited page set up by click ing on OK in this win dow and in the Page Setup 
Man ager win dow.
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Confirming your Linearization on Press

• Choose Out put -> Print Cal i bra tion… from the RIP menu.

• In the di a logue box, choose the page setup just ed ited and click on Print cal i brated
tar get. The cal i bra tion tar get will be ripped and writ ten to disk.

• Fol low the pro ce dures used for print ing the uncalibrated tar get, and con firm that the 
out put is lin ear on your plate.

Calibrating your Press

Calibrating your press using the Actual Press Curve function will provide you with a
linear press sheet, so that 10% on screen prints as 10% on press, 50% as 50% etc.

If we stop here, there are many circumstances where this, whilst being accurate, is not
really desirable.

Typically older press work produced by film will suffer press gain at around 20% and
this gives a warm, strong image. A linear calibration will often produce a very
flat-looking result. However, linearising your press is important since it provides a
starting point and removes the variables caused by varying press gains and worn press 
rollers which can be created in a multi-press environment.

Once you have linearised your press and have created a calibration which we call the
“Actual Press” calibration, we can then add an intended press calibration curve, thus
enabling a print shop with multiple presses to create a more consistent and even
calibration across all its work.

• Start the Nav i ga tor RIP.

• If nec es sary, open the Out put Con trol ler / Mon i tor win dow by ei ther press ing
Ctrl+O or choos ing Out put -> Out put Con trol ler from the RIP menu.

• Make sure that Dis able Out put is checked. This will al low you to con trol the start of 
print ing in the next steps.

• En sure that you have ap plied a Plate cal i bra tion to the page setup you wish to cre ate 
a press cal i bra tion for (see ear lier in this chap ter).
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• Choose Out put -> Print Cal i bra tion from the RIP menu.

• Choose a page setup and click on Print uncalibrated tar get. The cal i bra tion tar get
will be ripped and writ ten to disk. You should get four sep a ra tions.

• Load a plate 

• In the Out put Con trol ler/Mon i tor win dow se lect Uncalibrated tar get in the Ac tive
Queue.
Click on the Info but ton to open the Through Put Info di a logue.
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• Click on Page lay out....

• Check that the Me dia Width, Me dia Length and Mar gins are cor rect for your plate.
(The cal i bra tion tar get is rather small, but you should check to en sure the mar gins
will put it in side your print ing area).
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• Uncheck Dis able Out put in the Out put Con trol ler / Mon i tor win dow.
Once the Through put win dow shows ac tiv ity, re-check the Dis able Out put
checkbox.
A tar get sim i lar to this il lus tra tion will be printed.

• Af ter the tar get has printed, re move the plate from the PlateWriter.

• Place the plate on the front of the PlateWriter's fin ish ing unit.

• Load the next plate and re peat the above pro ce dure for each plate.

• Each plate should then be put on the print ing press, and an even ink den sity should
be achieved be fore print ing ref er ence sheets.

In Eu rope the Fogra Stan dard sug gests se lect ing three typ i cal types of pa per stocks:

- Gloss Art: Set the ink den si ties to C=1.37 D, M=1.4 D, Y=1.03D, K=1.53 D
- Silk/Matt: Set the ink den si ties to C=1.16 D, M=1.24 D, Y=1.01 D, K=1.46 D
- Un bolted: Set the ink den si ties to C=0.76 D, M=0.93 D, Y=0.75 D, K=0.97 D

Each pa per stock re acts dif fer ently to the press ink and changes the gain achieved on
press. Sim i larly the amount of ink laid down will im pact re sults. So if you do not wish
to ad here to the Fogra stan dards, then en sure you have some con sis tent den si ties that
you will to con tinue to work with. 

For ex am ple, stan dard Com mer cial Work in the USA would typ i cally see the ink
den si ties set to C=1.37 D, M=1.38 D, Y=1.06D, K=1.75 D

• Run each stock through the press, en sur ing your ref er ence sheet achieves the cor rect

ink den sity.

• Once the sheets are dry, use a high qual ity re flec tion den si tom e ter ca pa ble of read -
ing sto chas tic dots, or com pa ra ble de vice, to mea sure the dot percentage for each of
the patches on the printed cal i bra tion tar get. It is not un usual for each ink to achieve
a dif fer ent gain char ac ter is tic, so you will need to sep a rately measure each colour
printed.
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• Choose Out put -> Cal i bra tion Man ager from the RIP menu.

• Choose Print ing Press as the De vice type.

• Se lect CMYK as the Col our Space.

• Click on New....

• Name the new cal i bra tion in re la tion to the press and pa per type that was used.

• Se lect the press type as lin ear and se lect the first col our chan nel Cyan to en ter the
cyan data into.

• En ter the mod i fied col umn of Dot percentage mea sure ments in the edit boxes.

• Once you have en tered the Cyan data se lect the Ma genta chan nel and en ter the data 
mea sure for the ma genta out put.

• Re peat the above for the re main ing colours.

• Click OK in this win dow and in the Cal i bra tion Man ager win dow to save your pro -
file.
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Including the Press Calibration in Page Setups

Editing the Page Setups

• Choose Page Setup Man ager from the RIP menu to open the Page Setup Man ager
win dow.

• Se lect the Page Setup that was used when print ing the uncalibrated tar get and click
Edit to open the Edit Page Setup di a logue.

• In the Cal i bra tion & Dot Gain sec tion se lect the Cal i bra tion you just cre ated from
the Ac tual Press cal i bra tion list.

• Leave the Tone Curves and the In tended Press curve set to (None).

• Save the ed ited Page Setup by click ing OK in this win dow and in the Page Setup
Man ager win dow.
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Why Use Intended Press or Tone Curves?

The calibration process we have outlined is used to linearize the printing process using 
the PlateWriter 2000.

Linear printing means that a nominal 50% dot (gray level) will print as 50% on press.
Typically this will result in light or “washed out” looking print since most images are
pre-compensated for 20% dot gain. This means that images are generally prepared
expecting a nominal 50% dot to print as 70%.

Intended Press Curves are used to add the expected gain back into the press profile.
Tone Curves are used to modify this further to create cool looking images or warm
images. We have not included any tone curves so this section details the use of the
Intended Press Curve to create the expected dot gain from conventional film etc.

We have included curves for Standard (20%), 15%, and 22% dot gain along with
Commercial, SWOP and Forgra curves with the Navigator RIP. These values are a
good starting point. 

You may need to fine tune these Intended Press Curves to meet your particular
requirements. However to use one of the existing Intended Press curves, follow the
procedure below to implement the Intended press curve in your Page Setups.

Including the Intended Press Curves in Page Setups

• Choose Page Setup Man ager from the RIP menu to open the Page Setup Man ager
win dow.

• Se lect the Page Setup that was used when print ing the uncalibrated tar get and click
Edit.

• In the Cal i bra tion & Dot Gain sec tion se lect as the In tended Press curve one of the
curves in cluded in the Nav i ga tor RIP in stal la tion or one of the curves loaded when
print ing the config.ps file, or any cus tom In tended Press curve you may have
created.

• Save the ed ited Page Setup by click ing OK in this win dow and in the Page Setup
Man ager win dow.

• You can con firm if the out put of your in tended curves achieves the re sults you re -
quired by print ing a Cal i brated Press Tar get.
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Backup & Restore your NavigatorRIP Configuration for
Windows

"
It is very simple to backup your configuration of the Navigator RIP.
If you follow this simple backup procedure, you will preserve all of your
Passwords, Memory settings, Calibrations, Tone Curves, Device and Page
Setups etc.

"
Having a backup of your RIP configurations is likely to save you hours of
work if any problems occur with your workstation or if you need to reinstall
the Navigator RIP.

Configuration Backup

Having configured your RIP follow the instructions below to make a backup file of
your settings:

• Start the Nav i ga tor RIP.

• Se lect Nav i ga tor -> Print file from the RIP Menu.

• In the print di a logue, set the Page Setup to De fault Page Setup and the Files of
Type to Post Script (.ps)

• Choose the file BackupConfiguration.ps which is found in C:\Pro gram
Files\Xitron_7.1r0\Util i ties.

• Click on Print.
This will cre ate (or over write an older ver sion of) config.ps and put it in the same
folder as BackupConfiguration.ps.

• Make a backup of config.ps on re mov able me dia and store it in a safe place.

How to Restore your Configuration

Follow the install instructions for Windows on the Navigator RIP install CD.
When you are instructed to print the config.ps file from the install CD, print the
config.ps file which you have backed up instead.
Follow the instructions to configure the RIP memory and dongle passwords.
Your entire configuration will then be restored, and you can resume work.
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Part 5: Troubleshooting

General

If the PlateWriter does not work properly, refer to the following pages to find the
paragraph that comes closest to your problem. The trouble shooting guide is divided
into 3 sections:

• Problems with the finishing unit
• Problems with printed material

"
To change a fuse, switch off all power to the machine first.
Always ensure that the new fuse is of the correct size and rating according to
the diagram.
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Problems with the Finishing Unit

Indicator Status and Error Codes

The finishing unit's status indicator lamp has several ways to indicate the current
status of the unit and/or unit errors.

GREEN - STEADY Finishing unit is ready.

GREEN - 1 FLASH Processing.

Wait for steady green signal before next plate is
put on the conveyor.

GREEN - 2 FLASHES
BUZZER SOUNDS

Plate on conveyor when oven is not ready.

Remove plate and wait for steady green signal
before plate is put on the conveyor.

GREEN - 3 FLASHES Plate too long or too short.

Remove plate.

RED -  1 FLASH Unit is not ready because conveyor and/or oven
sensor is covered.

Uncover both sensors.

RED -  2 FLASHES Program selection out of range.

Set correct program.

RED -  3 FLASHES
BUZZER SOUNDS

Bulb error - one or more bulb in the oven are
blown.

Power the unit off, replace bulb, then power the
unit on again.

RED -  4 FLASHES Motor regulation error - motor/conveyer is
blocked.

Power the unit off, remove obstacle, then power 
the unit on again.
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Problems with Printed Material
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